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©1989-1990 Semafor Software ANS. All rights reserved.

MacTCP is a copyrighted program of Apple Computer, Inc., licensed to
Semafor Software ANS to distribute only in combination with ORBIT
Terminal. APPLE, APPLE COMPUTER, INC. AND THEIR AFFILIATES
MAKE NO WARRANTIES, EXPRESS OR IMPLIED, INCLUDING WITHOUT
LIMITATION THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE, REGARDING THE APPLE
SOFTWARE. IN NO EVENT WILL APPLE, APPLE COMPUTER INC. OR
THEIR AFFILIATES, WARRANT, GUARANTEE OR MAKE ANY
REPRESENTATIONS REGARDING THE USE OR THE RESULTS OF THE USE
OF THE APPLE SOFTWARE IN TERMS OF ITS CORRECTNESS,
ACCURACY, RELIABILITY, CURRENTNESS OR OTHERWISE. THE
ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE APPLE
SOFTWAREIS ASSUMED BY YOU. THE ABOVE EXCLUSION MAY NOT
APPLY TO YOU. IN NO EVENT WILL APPLE, ITS DIRECTORS, OFFICERS,
EMPLOYEES OR AGENTS BE LIABLE TO YOU FOR ANY
CONSEQUENTIAL, INCIDENTAL OR INDIRECT DAMAGES (INCLUDING
DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS
INTERRUPTION, LOSS OF BUSINESS INFORMATION, AND THE LIKE)
ARISING OUT OF THE USE OR INABILITY TO USE THE APPLE SOFTWARE
EVEN IF APPLE HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES.
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The first entry in the table corresponds to characier code 101. When a button is pressed the table
is used in the following way to send a code sequence (pseudo-Pascal):

var cpal: CPALRecord;
csiCode: Integer;

cpal := (CPAL resource) { (the buttons refCon) - 101); {Get record}
case cpal.f of
0: Send(cpal.g):;
1,2: begin
if controlKeyWasDown and cpal.ctrlCSI # 0 then
csiCode := cpal.ctrlCSI
else if shiftKeyWasDown then
csiCode := cpal.shftCSI
alse
csiCode := cpal.CSI;
if csiCode = 99 then {Break state aslong as the mouse button is down} ;
if not extendedControlMode then
if cpal.f = 1 then Send(cpal.g)
else
case cpal.g of
1: begin Send('0'); Send(°0°} end;
2: begin Send('0'); Send(‘0'); Send('0') end;
end
- @lse if csiCode # 99 then
Send (escape, [, csiCode as two digits, _ ):;
end;
3: Aif clearLampsSwitch in [both,key] then
ClearLamps {(EXP, APP, BUSY, MSG};
4: if shiftKeyWasDown then
Send (PushKey (cpal.shftCSI + 8))
else
Send (PushKey (cpal.shftCSI));
end;

® Apple and Macintosh are registered trademarks of Apple Computer Inc.
™ MacTCP and LocalTalk are trad ks of Apple C

puter Inc.
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Text printed on the terminal can be saved in a Macintosh file (capture). Small amounts of text
can be pasted in, and thus sent to the host. Other file transfer capabilities depend on the kind of
communication you are using (see below).

ORBIT Terminal is available in two versions. The first, ORBIT Terminal/Serial communicates
via the serial port only. The second, ORBIT Terminal/TCP, supports both serial port and Telnet
communication, and is intended primarily for users who have Ethernet. Using ORBIT Terminal
with Telnet communication requires Macintosh System version 6.0.3 or fater. Serial
communication will work with some older System versions as well,

With serial communication, the possible communication protocols are determined by the
Macintosh hardware: V.24 (R$232) with a baud rate of 300 or more may be used. V.11 (current
loop) is not supported. The speed of ORBIT Terminal is approximately the same as that of the
Tandberg 2200/9S. Except for capturing text printed on the terminal, file transfers require the
use of an appropriate program on both the Macintosh and the host. We recommend Kermit, a
public domain program found on many computers. Additional information about Kermit may be
obtained from Semafor Software.

TCP/IP communication is based on MacTCP™ (delivered together with ORBIT Terminal), and
can therefore run on hardware configurations supported by MacTCP. These include Ethernet
cards that plug into the Macintosh, gateways, and ordinary LocalTalk™ cabling. Terminal
emulation uses the Telnet protocol, and file transfers can be performed using the FTP protocol.

ORBIT Terminal has been designed and tested using Norsk Data host computers. Application
software on ND-100 and ND-500 computers should run without problems, NOTIS and
QED-like editors work correctly. ORBIT Terminal has been designed to support terminal type
93, but terminal types 53 and 83 will also work.

ORBIT Terminal can be run in the background under MultiFinder. ORBIT Terminal runs faster
when the Macintosh screen is set to black and white only, rather than to grays or colors. ORBIT
Terminal/Serial requires 180K bytes of memory. ORBIT Terminal/TCP requires 280K bytes.

CONNECTING UP FOR SERIAL COMMUNICATION

The host computer is connected to the Macintosh via a cable plugged into one of the Macintosh's
serial connectors (either the modem connector or the printer connector). These connectors
support RS422/423 as well as RS232 (V.24) communication, ORBIT Terminal will run with
any host able to communicate using the Macintosh protocols. Note that this means that not all
communications protocols supported by Tandberg terminals can be used with ORBIT Terminal
(specifically, not current loop [V.11]).

In general it will be possible to connect a computer with an RS232 interface to the Macintosh.
You can also use ORBIT Terminal when the host is remotely connected via modem. The cable
construction is then determined by the modem hardware.

nnectin Norsk Data h

To connect the Macintosh directly to a Norsk Data host, make sure the switch on the Norsk Data
computer’s interface card is set to R$232 (not current loop). Remember to set the speed
correctly (9600 baud will work fine). The cable between a Norsk Data computer and Macintosh
should be constructed according the diagram below. This cable is for Macintosh Plus or later;
early Macintoshes used a DB-9 connector. Pin-out for the DB-9 connector is described in
Macintosh Technical Note #65. If it is absolutely necessary to use current ioop rather than

RS5232, such as when the building is wired for current loop, a hardware current loop converter
must be used.

Page 2
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Fonts

The following are changes to the Tandberg:
» Method of accessing soft switches uses Macintosh dialog boxes.
» Make Permanent is separate for each set of switches. Each set is handled identically.
¢ Auto-repeat works for all keys on Macintosh keyboard, but not with the mouse button,
< Time-out and bell moved to menu 1 (convenience switches) from menu 2.
« The break key (command-Exit) will hold the line in a break state as long as it is held
down, minimum 1/2 second. (In some Tandberg revisions the time is controlled by
a communication switch called Break Length.) If you have a Telnet connection,
the break key sends a Telnet BRK. :
» Communication protocols supported are those supported by Macintosh hardware.
Communication switches not implemented:
Communication Mode, Communication Clock
V.11 (current loop) not supported. RS232 (V.24), R$422/423 supported.
Baud rates under 300 not supported. New high baud rates are supported.
1.5 Stop Bits is possible.
ORBIT Terminal/TCP supports communication via the MacTCP software; in
this case, many of the ordinary communication parameters are not relevant.
+A delay has been added after ESC in a push key (so that push keys can be
used to log in with Norsk Data hosts).

CUSTOMIZING

This section contains information on how to customize ORBIT Terminal 1.4 using a resource
editor. It is written for advanced Macintosh users. Only resources particular to ORBIT Terminal
or resources used in a special way are explained. Resources that can be edited in a
straightforward manner (dialog boxes, strings, etc.) are not discussed.

Telnet and FTP parameters

The following resources may be edited to change various parameters of the communication.

STR 257 Timeout (in seconds) for connecting
STR 258 Timeout (in seconds) for FTP data connection disconnect
STR 259 Number of FTP response lines buffered for response panel in window

STR# 300 Terminal type response strings (Telnet terminal type option, not used by
Norsk Data hosts).

Many special fonts are used by ORBIT Terminal. All are included in the application file.

".TDV1" through ".TDV15" are the various 2200/9S character sets. Each occurs in nine sizes
(10-18) corresponding to the possible screen sizes. ".TDV1" is the normal character set. It also
contains the cursor and underline characters. The line cursor, block cursor, and underline

character are nos. 29, 30, and 31, respectively.

".TDVControl” is a modified version of Chicago with characters representing the control
characters. These are character nos. 64-95. This font is used in the push key dialog box.
".TDVChicago" is a modified version of Chicago with extra Icelandic characters. This font is
used in the push key dialog box.

".TDVButtons xxx" contains the button legends for language xxx. If new languages are defined,
new versions of these may be added on any unused font ID.
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Then press ESC again. Try pressing Return one or more times.) Log in and use the computer as
usual. When you are finished log out as usual.

GETTING STARTED WITH TCP/IP COMMUNICATION

First, MacTCP must be installed. If you have several applications that use MacTCP, it only
needs to be installed once. Insert the ORBIT Terminal disk. Copy MacTCP and the Hosts file to
the System Folder of your start-up disk.

(If you have installed other TCP communications software that does not use MacTCP, it may not
be compatible with MacTCP. It may be necessary to restart your Macintosh in order to change
from one to the other.)

Use the Control Panel in the Apple menu to configure MacTCP. For most users, it is sufficient
to enter your own IP address. Click the More button. Change the Obtain Address radio button
setting from Server to Manually. Click OK. Click OK for the restart message. Enter your IP

address in the original control panel box. Click the close box. Click OK for the restart message.

Restart your Macintosh,

To start ORBIT Terminal, insert the ORBIT Terminal disk. If you wish, copy the program and
the help file to your hard disk. Double-click the ORBIT Terminal icon. The program should
display the extra Tandberg key palette and the blank Tandberg screen.

Choose Communication switches from the Configuration menu. Set the Port switch to TCP/IP
to activate TCP/IP in ORBIT Terminal. Click OK.

You can now use ORBIT Terminal to communicate with machines on the network. If you are
going to use the same host most of the time, use Default Host in the Network menu to set the
host name or address. Use Open Connection in the Network menu to open a Telnet connection
1o a host (specified by name or IP address).

If the host is a Norsk Data computer, press ESC (or click it in the palette) to get the log-in
messages. When the computer asks for terminal type, you should answer 93 (or 53 or 83). Log
in and use the computer as usual. When you are finished, log out as usual. If the host is a
Norsk Data computer, an alert appears stating that the connection went down. If you want to log
in as another user, choose Open Connection again.

If you have trouble establishing a connection, you may need to restart the Macintosh between
trials (in case MacTCP has gotten into a bad state). By holding down option and choosing in the
File menu, you can also bring up a debug window that may help in identifying the problem.

If you have a complex network with a network administrator, it is possible for the administrator
to pre-configure MacTCP before distributing it. Contact Semafor Software for more
information,

About the Hosts fil

The Hosts file maps machine names to internet addresses, which is the same service provided by
the domain name system. You can use the Hosts file if there is no domain name server on your
network. It is also convenient to place frequently used name-to-address mappings in this file. In
dialogs in ORBIT Terminal, you can specify a host using a pop-up menu over Host file entries.

To use the Hosts file, you must customize the sample file and add text that defines
name-to-address mappings. The file is a text file, and can be customized with TeachText, text
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a directory double-clicking sets the current directory (moves down, except for the parent
directory name which moves up) . If the name is a file, the file is fetched. If this scheme is too
simple to work with the file system of the host, you can use the receive file button and the CWD
command,

Entering FTP comman

Advanced users can type commands in the FTP command panel at the bottom of the FTP
window. The response to each command is shown in the FTP response panel. Each command
causes at least one line to appear in the response panel. The information below gives some basic
guidelines, and lists some of the most common FTP commands.

Typing HELP produces a list of commands available on the server. Some servers give a long list
containing both implemented and non-implemented commands. Non-implemented commands
are usually marked by an asterisk, or the help response explains how to identify them.

An FTP command consists of the command name followed by one space and the argument, if
any. Case is not significant in command names. Initiate the command by pressing return. Some
common FTP commands are:

USER username Use when no automatic log in. oqurr  Disconnect from server.
PASS password

ACCT account-info RMD Remove directory.

MKD Make directory.
cwb pathname  Change current directory. PWD Print name of current directory.
cpup Change to parent directory.

TYPE A Use ASCII file transfer.
RETR pathname Transfer file to Macintosh. TYpE I Use Image (binary) file transfer.
STOR pathname Transfer file to host.

For NCSA Telnet MacBinary:
LIST List files. mMace  Disable MacBinary
NLST List files. MacB £ Enable MacBinary.
RNFR pathname Rename from: old file name. syst  Print name of operating system.
RNTO pathname Rename to: new file name. STAT Print current status.
HELP  Print the list of commands.
DELE pathname Delete file. NOOP Do nothing. See if server answers.

SUMMARY OF DIFFERENCES WITH TANDBERG TERMINAL

The following summarizes the differences between ORBIT Terminal and Tandberg terminals.
This list is based on Tandberg documentation TDV 2215 S, Functional Specifications, publ. no.
5176, April 1985 and TDV 2200/9 S User's Guide (ND), publ. no. 5509, November 1984.

The following extensions to Tandberg are included:

* Push keys can have as many characters as desired.

* Screen contents are not lost when setting switches.

* A new Low Intensity convenience switch allows low intensity to be ignored.

* A new CR in Paste convenience swiich allows line feeds to be automatically inserted
after carriage returns in text sent to the host during paste.

* A new Command Key convenience switch determines whether the command key on the
Macintosh keyboard is used to generate control characters or as the normal menu
shortcut.
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The behavior of the command key (38) is determined by the Command Key switch in the
Convenience switch dialog. The switch determines whether the command key works as a
control key (for typing control characters) or as the ordinary Macintosh shortcut for menu
commands. When Control is chosen, the command and control keys work identically;
otherwise, you must must use the control key to type control characters. When Command is
chosen, command key equivalents show in the menus.

The keys and lamps not found on the Macintosh keyboard are displayed in the key palette. To
press one of these keys, place the mouse cursor over the key and click. The code(s) associated
with the key will be sent to the host machine. The following shows the layout of these keys for
the International language setting:

Keyboard equivalents can be defined for these Tandberg keys. This is done by associating
characters in Macintosh extended ASCII (for most of them, hold down the option key) with a
Tandberg key. Choose Keyboard Equivalents from the Configuration menu to change the
definitions. The dialog box contains a double entry for each code in Macintosh extended ASCII.
Press the key on the keyboard for which you wish to define an equivalent. The character it
generates will be highlighted briefly. Drag the picture of the Tandberg key to the character. If
you plan to use the automatic SuperShift feature, you should try to avoid equivalents for the
same characters that should generate SuperShift sequences (the equivalent has priority).

When using keyboard equivalents, the state of the shift key is significant. For example, to have
an equivalent for both F1 and shift-F1, you must associate the F1 key with two characters in the
extended ASCII set. One character is generated without holding down the shift key, while the
other is generated using shift. Another example is the push keys, e.g. P1 and P9. To get both
on the same keyboard key, you must define two equivalents.

If you have the extended Macintosh keyboard, you can associate the extra Tandberg keys with
keys on the extended keyboard. Choosing Extended Keyboard Equivalents from the
Configuration menu lets you change the definitions in a way similar to ordinary Keyboard
Equivalents. To retrieve the original preset definitions, click the Default button.

If you wish, you can temporarily stop output on the screen in order to read what is already there.
Choose Suspend in the Edit menu to suspend output, and choose it again to resume, If you
have the Command Key Convenience switch set to command, you can press command-S.
The suspend function can also be mapped to the keyboard keys control-S (suspend) and
control-Q (resume) using the Suspend/Resume Convenience switch.

The desired Language is specified in the Convenience switch dialog. Options correspond to
the various Tandberg terminal versions: International (US ASCH), Norwegian, Swedish,
Danish, English, SDS, French, Swiss, German, FAO, Finnish, Icelandic and several variations
of Nortext keyboards. The choice of language affects:

* The appearance of the panel of Tandberg keys at the top of the screen.

« The escape sequences that are associated with the keys in the panel.

« Conversion of characters sent to the host (Macintosh extended ASCII to standard ASCII).

+ Conversion of characters received from the host (standard ASCII to Macintosh extended).

Character conversions enable the usual use of special letters in the standard portion of the ASCII
character set, e.g. {JI[]\ are converted to and from Az EcEp@B60AA as appropriate for
Scandinavian languages. An experienced user who can use a resource editor can add new
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For Norsk Data hosts, the file panel lists the files of the current user. Browsing is unnecessary
because Norsk Data computers do not use a hierarchical file system.

Before you transfer a file, check the Text, Binary, and MacBinary settings. More
information about whether to use Text or Binary may be found in the section called About File
Transfer. If you know that the file is a standard text file, you may want to transfer it as text.
Otherwise, transfer it as binary.

Checking MacBinary enables MacBinary transfers. MacBinary transfers make it possible to
send Macintosh files (including type, creaior, icons, and both forks) over the network. Without
MacBinary, only the data fork is sent. MacBinary files are virtually useless on any other
machine than a Macintosh. If your host is not a Macintosh, the main use for MacBinary is for
archiving Macintosh files that you transfer back to a Macintosh when you want to use them.

If MacBinary is checked, the Send File operation will cause files to be sent as MacBinary. The
Receive File operation checks the incoming file for a MacBinary header and, if found, receives
the file as MacBinary. This means that the file name, icon, etc. will be set up from the
transferred file.

The Send File... button causes a file to be sent from the Macintosh to the host. You specify
which file to send using a standard Macintosh dialog. The file will be transferred to the current
directory of the host computer. If the host has a hierarchical file system, browse to the directory
where you want to place the transferred file before clicking Send File.

The Receive File... button causes a file selected in the file panel to be sent from the host to the
Macintosh. Receive File can also be activated by double-clicking a file in the file panel. A
standard Macintosh dialog appears to allow you to name the transferred file and place the it in the
desired folder.

While transfers are in progress, a small hourglass is shown below the Settings button. No FTP
commands may be executed when the hourglass is showing. You can, however, use the
Terminal window while the transfer proceeds in the background.

The FTP response panel gives feedback about how the current operation is proceeding. Each
response is an answer given by the host to an FTP command. A response consists of a 3-digit
number and an explanatory text. The number is for use by computers, and the text is (mostly)
for use by humans. When file transfer concludes the number of bytes transferred and the
transfer rate are shown. For most users, it is not necessary to understand the contents of the
panel, but you will probably find it useful to follow along.

The next two sections contain information on the Settings dialog, brought up by clicking on the
Settings button, and on using the FTP command panel at the bottom of the window.

Clicking in the close box removes the FTP window. Before clicking the close box, you should
click Disconnect to terminate the connection gracefully.
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The table contains entries for each character in the Macintosh extended ASCII set (codes
128-255). The Macintosh character appears at the left, while the SuperShift characters to send
appear at the right. For example, when using the above table, pressing ¢ on the Macintosh
keyboard causes SuperShift *. to be sent to the host. If you want to change it, select the entry
and enter the new characters that should be sent.

TEXT CAPTURE

Text Capture is used to save output that appears on the terminal in a text file. You can use text
capture to make a record of your session with the host. This is especially useful if you use
ORBIT Terminal to access bulletin boards through a modem.

You can also use text capture to transfer a text file from the host to the Macintosh by listing the
text on the terminal with an editor. This is most useful if you are using serial communication;
users with TCP/IP communication can usually use FTP instead. If you are using serial
communication with XON/XOFF, you can transfer large amounts of information without
problems. For Norsk Data hosts, you should use the COPY command in Sintran (not
COPY-FILE). You can also use QED or a similar editor, but not NOTIS-WP since it sends
screen control characters.

To start the capture, choose Text Capture from the File menu. A dialog box appears to allow
you to specify a text file. All output that subsequently appears on the terminal will also be
written to the text file. When you wish to stop, choose Stop Capture from the File menu.

You can find some general information about transferring files in the section called About File
Transfer. The steps for transferring a text file from a Norsk Data host to the Macintosh using ‘
capture are listed below.

«Start ORBIT Terminal and log onto the Norsk Data machine as usual.
*Enter the Sintran command "COPY TERMINAL <file name>". Don't type carriage )
return yet. The file name is the name of the text file that you want to transfer. Be sure it is
a "raw" text file and does not contain control characters. Use COPY rather than
COPY-FILE to avoid junk on the end of the file.
*Choose Text Capture from the File menu.
*Enter the name that you want the document to have on the Macintosh. ("“Capture File" is
the name suggested in the dialog box.) Click OK. Text capture is now turned on.
*Type the carriage return to initiate the copy command to Sintran. The text file will now be
listed on the terminal. At the same time, the text is copied to the capture file. If you don't
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FILE TRANSFER USING FTP

With TCP/IP communication, the usual way of transferring files is via FTP. Choosing FTP...
in the Network menu brings up the FTP window. This is a non-modal dialog window, so it is
possible to have active sessions in both the terminal window and the FTP window at the same
time. (

ORBIT Terminal/FTP

Host o JF addr W _ Connect _

Password _ Account

& Liok Fites
Receive File..,
Send File, .

@ Text O Binary
s

Gy 3

<

3

<l

Here is a summary of how to use FTP (when nothing goes wrong and everything is set up). In
the following sections you'll find more information about what the various settings and buttons
mean. The first time you use FTP, you should check the Settings. If you are transferring to or
from a Norsk Data host, the settings as delivered should work. Then follow these steps:

*Enter the host name (you can use the pop-up menu under the small icon at the right for
names in the Hosts file), user, password, and account as needed. For Norsk Data
hosts, enter the user and the Sintran password; the account is not needed.

+*Click Connect to establish a connection.

*To send a file:
«Set whether to send the file as text or binary. If in doubt, try binary.
°If sending binary, set whether to send MacBinary. If in doubt, try leaving it off.
+Click the Send File button.
*A dialog box appears. Find the file you want to send and click OK.
*The hourglass appears to show that the file is being transferred.

*To receive a file:
*Set whether to receive the file as text or binary. If in doubt, try binary.
*If receiving binary, set whether or not to check for MacBinary. You may want to
try turning this on if the file might be a MacBinary file.
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Binary files usually contain programs, or data for a specific program. Examples of binary files
are an ordinary NOTIS-WP file (S-format) or an ordinary MacWrite document. In many cases,
itis not interesting to transfer binary files because there is no software on the receiving machine
that can make use of the information. For example, in order to use a NOTIS-WP S-format file
on a Macintosh, you need to use a converter to one of the Macintosh word processor file
formats. (See the Other File Transfers section below). Even with such a converter, the result is
not usually perfect, due to differences in the capabilities of NOTIS and the Macintosh word
processor. The moral: before investing great effort in physically transferring the files, be sure
you have software that can handle the transferred files.

When transferring text files, the transferring programs may try to adjust certain aspects of the file
to the receiving computer’s conventions. Examples are end-of-line character(s), parity bits, and
character conversions. When transferring binary files, the entire file is always transferred "as is"
without modifications of any kind.

In almost all cases, you can physically transfer pure ASCII files (raw text) to the Macintosh. The
exception is using serial communication without XON/XOFF. Most Macintosh editors can read
pure text files, so you'll be able to use the information you transfer. To get a pure ASCII text file
in NOTIS-WP, the 7-bit format must be used. (Use the Func-O command to convert existing
documents.) Formatting information cannot be transferred, and is lost in NOTIS-WP when
converting to 7-bit format. It is not possible to transfer characters in the Tandberg's extra
character sets, e.g. graphics characters. Only the "raw” text can be transferred. Transfer the text
using Text Capture as described in the section on Text Capture. Once the text is on the
Macintosh, it can be read by most word processing programs. Then, you can add formatting
information manually using that program.

‘The process of transferring text to the Macintosh is suitable when you only need to transfer the
text once, and are willing to "fix it up" on the Macintosh side. It is not suited to transferring text
back and forth, first working on the host and then on the Macintosh. Such a solution would
require either word processing software on both machines with compatible data formats, or extra
software to convert between formats. In addition, the formats would likely be binary rather than
ASCII so that ORBIT Terminal with serial communication could not be used to do the actual data
transfer (see below).

Macintosh has an extended ASCII character set that permits a total of 256, instead of the usual
128, characters (8 bits, instead of 7 plus parity, are used for each character). Thus, Macintosh
text files that contain characters in the extended part of the character set cannot usually be
interpreted by other computers. In other computers, extended characters (such as Scandinavian
iogd) are usually made by "stealing” characters (such as [\ }I) from the standard 7-bit set. This
means that transferring 7-bit files to the Macintosh without any character conversion may
produce strange results (all of the 3 characters will become \ etc.). ORBIT Terminal provides
tables for converting the extended part of the ASCII set to and from specified characters in the
standard set. These tables can be customized if necessary by advanced users; see the Languages
part of the Customizing section.

Macintosh files containing characters in the extended part of the ASCII character set may need to
be transferred as binary files. For example, if you want to store a Macintosh text file on a Norsk
Data computer that you will later use on a Macintosh, transfer it as binary (or MacBinary, if you

can). If you want to use the file on a computer with standard ASCII, transfer it as a text file.

With serial communication, it is not possible to transfer large amounts of data from the
Macintosh to the host without risking loss of data. This is because there is no protocol in that
direction; that is, the terminal sends characters to the host whether or not the host is prepared to
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Tabulation Rack
When Tabulation Rack is chosen a dialog box appears.

Tabulation Rack

(Make Permanent)

The small black rectangles show the position of tabs. To remove a tab, click it. To add a tab,
click at the desired position. All tabs may be cleared by clicking the Clear button.

THE NETWORK MENU

The Network menu is found only in the ORBIT Terminal/TCP version. It contains the Telnet
and FTP commands.

Open Connection...
Close Connection
FTP...

Send "fire You There?"
Send "Abort Output"
Send "Interrupt Process"
Send "Erase Character”
Send "Erase Line"

Default Host...

Version 1.4b February 1991 Page 15
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ORBIT Terminal Owner's Manual

Time-out <On <Off
As on Tandberg.

Bell «On -Off
As on Tandberg.

Low Intensity <Low Ignore

This is a new switch in ORBIT Terminal. It tells how low intensity should be represented on

the Macintosh screen. If the switch is set to Low, low intensity will be represented by
removing some pixels from the displayed information. Since this can make text difficult to
read, it is possible to ignore low intensity being sent from the host by setting the switch to
Ignore. Changing the switch affects characters as they are written to the screen; it will not
alter the appearance of characters already displayed.

CRin Paste -CR only *CR and LF
This is a new switch in ORBIT Terminal. It tells whether line feed should be added after
each carriage return when pasting. (See the Paste section for more details.)

Command Key <Control *Command

This is a new switch in ORBIT Terminal. It determines whether the command key works as

a control key for typing control characters or as the ordinary Macintosh shortcut for menu
commands.

Use Mouse +On <Off
This is a new switch in ORBIT Terminal. When off, mouse clicks are ignored in the area
representing the Tandberg screen. When on, mouse clicks generate codes that are
appropriate to Notis and Nortext. See the section on Features for Notis and Nortext Users.

Numeric Pad +Normal <Option Key
This is a new switch in ORBIT Terminal, and is useful when the Numeric Pad Function

switch is set to Function. If the Convenience switch is set to Normal, the Numeric Pad will

generate function key sequences. If, however, it is set to Option Key, the option key must
be held down in order to generate the function key sequences; otherwise, ordinary numeric
sequences are generated. This method of operation allows you to have both numeric pad
mechanisms available all of the time.

Suspend/Resume +AS/AQ <Off

This is a new switch in ORBIT Terminal. When on, you can press control-S to temporarily

stop output on the screen, and control-Q to resume. This is useful when you want to have
time to read the contents of the screen. ;

Language
This is a new switch in ORBIT Terminal, but the choices correspond to various language

versions of the Tandberg terminal. Current choices are: International, International Nortext,

Norwegian, Norwegian Nortext, Swedish, Swedish Nortext, Danish, English, SDS,
French, Swiss, German, FAO, Finnish, Icelandic, and Icelandic Nortext. The setting
determines the appearance of the panel of Tandberg keys at the top of the screen, the escape
sequences they generate, and the way characters are converted to and from Macintosh
extended ASCII when they are sent to and from the host. For Scandinavian languages, the
switch defines conversions between 4Az/ExEp@O4A in Macintosh extended ASCII and
{)I[]\in standard ASCII. If your copy of ORBIT Terminal has been customized, other
choices of language may be available, or a particular language may work in a special way.

Auto SuperShift
This is a new switch in ORBIT Terminal. Its purpose is to allow you to type special
characters on the Macintosh keyboard, and have them converted into SuperShift sequences
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used in Notis and Nortext. For more information, see the section on Features for Notis and
Nortext Users.

Function Switc!

Carriage Return +CR only *CR and LF
As on Tandberg.

Beginning of Line Wrap +Stop *Wrap
As on Tandberg.

End of Line Wrap +Stop *Wrap
As on Tandberg.

Roll/Page Mode -Roll *Page
As on Tandberg.

Roll Type <Step *Smooth
As on Tandberg.

PUSH-Key Programming +Allowed <Prohibited
As on Tandberg.

Extended Control Mode +Off +On
As on Tandberg.

Numeric Pad <Numeric *Function
As on Tandberg.

Vertical Editing Mode <Following *Preceding
As on Tandberg.

Clear Lamps +Both *Key *SYN
As on Tandberg.

Graphic Rendition Mode  +Attribute +Underline *SGR
As on Tandberg, except that blinking is not implemented.

Underline Representation Combination of *Undetline *Inverse Video Low Intensity
As on Tandberg. This switch can be set only when Graphic Rendition Mode is set to
. Underline. Each switch choice is set separately. Blinking is not implemented.

Baud Rate +300 +600 <1200 *1800 +2400 *3600 4800 <7200 9600 «19200 57600
These are baud rates supported by Macintosh hardware. Tandberg calls the switch
Transmission Speed.

Data Bits +7 Bits +8 Bits
As on Tandberg, except that it is called Transmit Code Length on Tandberg terminals.

Stop Bits <1 Bit <1.5 Bits <2 Bits
As on Tandberg,.

Version 1.4b February 1991 Page 13



